
  Quick 
Reference Guideersion 2 – 21/08/2019 
 

 

 
 
 

 

TRIM – D16-14084 

 

September 2019 

 
 

 

 
 
 
 

OrgTRx Module User Guide 
 

 
 

HTML 
 
 

September 2019 
 
 

 



 

 

 

 

Contents 

Contents ....................................................................................................................................................... 2 
1.  Aim ....................................................................................................................................................... 4 
2. Scope .................................................................................................................................................... 4 
3. Exclusions ............................................................................................................................................. 4 
4. Introduction ............................................................................................................................................ 4 
5. Terms & definitions ................................................................................................................................ 5 
6. Access & Login ...................................................................................................................................... 5 
7. Support .................................................................................................................................................. 5 
8. General navigation................................................................................................................................. 5 
9. Necto work area .................................................................................................................................... 6 
9.1 Table view screen (filtering slicer) .......................................................................................................... 7 
9.2 Adding a slicer ....................................................................................................................................... 8 
9.2.1Add additional slicers ............................................................................................................................ 8 
9.3 Search for member in a slicer ................................................................................................................ 9 
9.5 Drill through ......................................................................................................................................... 10 
9.5.1Profile report ....................................................................................................................................... 10 
9.5.2Profile report drill down ....................................................................................................................... 11 
9.6 Select members ................................................................................................................................... 12 
9.7 Select highlighted members ................................................................................................................. 13 
9.8 Add and remove dimensions ............................................................................................................... 14 
9.9 Replacing sets ..................................................................................................................................... 15 
9.10 Change grid layout............................................................................................................................... 15 
9.11 Rotate grid ........................................................................................................................................... 16 
10 Saving workboards .............................................................................................................................. 16 
10.1 Create a folder structure ...................................................................................................................... 17 
10.2 Save a workboard to your private content folder .................................................................................. 17 
10.3 Open a private workboard .................................................................................................................... 18 
10.4 Export .................................................................................................................................................. 19 
11 Sharing workboards ............................................................................................................................. 19 
11.1 Sharing a workboard with another user ................................................................................................ 19 
11.2 Open a shared workboard ................................................................................................................... 20 
12 Chart functionality ................................................................................................................................ 21 
12.1 Modify a chart ...................................................................................................................................... 22 
12.2 Select data to display in the chart ........................................................................................................ 23 
 
  

OrgTRx module user guide DSS Necto 



 

 
OrgTRx module user guide - DSS 

Necto v1.4 3 
 

 

Version Release date Business area contact 

1.0 September, 2015 Communicable Diseases Branch, Prevention Division, Department of Health 

Email: cdu.online@health.qld.gov.au  

1.1 September, 2015 Removal of Queensland Health specific access information 

L. Davis 

1.2 January, 2017 Updated support contact email address 

L. Davis 

1.3 May 2017  Updated formatting & numbering 

L. Davis 

1.4 July 2018 Updated to Necto 16 (DSS) 

1.5 September 2019 Updated with HTML5 changes 

 

  

mailto:cdu.online@health.qld.gov.au


 

 
OrgTRx module user guide - DSS 

Necto v1.4 4 
 

1. Aim 

The aim of this OrgTRx user guide is to assist those requiring access to and reporting on antimicrobial data. 

2. Scope 

 This user guide provides information to enable the user to perform the following tasks within OrgTRx: 

 request access to the Antimicrobial workboards 

 access the Necto work area through the application bar 

 filter a slicer 

 use the dimension selector 

 drill up, drill down, and drill through data 

 generate a profile report, and subsequent drill through 

 select members 

 add and remove members or sets 

 select highlighted members for viewing 

 add and remove dimensions via the grid 

 replace sets (Cumulative Antibiogram workboard only) 

 change the grid layout 

 rotate the chart 

 create a folder structure for saving workboards in Private content folder 

 save, share, and open workboards 

 export data in various formats (PDF, Excel, image) 

 view and customise workboard charts. 

3. Exclusions 

This guide is for DSS (the system) functionality only and does not cater for individual position 

responsibilities or workplace processes required to effectively use the system. 

Requirements: 

 DSS access 

 Basic windows navigation skills (expand and collapse folders/trees). 

4. Introduction 

The OrgTRx (antibiogram) system collects susceptibility data from the laboratory information system and 

makes a data cube available through the Queensland Health Decision Support System (DSS).  This 

enables the development of cumulative antibiograms and investigation of resistance trends.  Clinicians with 

responsibility for antimicrobial stewardship (AMS) such as infectious diseases physicians, clinical and 

laboratory microbiologists, and specialist pharmacists have access to the data which they use to inform 

their local AMS program.  
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5. Terms & definitions  

Term Definition 

Dimension Represents a category for defining members. It may be flat or have a hierarchal structure 
with multiple levels, each of which contains members of the dimension (i.e. dimensions 
are microbial, facility ward etc.).  

Member  A member is a selection within a dimension. For example, for the dimensions – 
‘specimen facility ward’ and ‘microbial’ - the members could be ‘specimen type’, ‘facility’ 
and ‘antimicrobial’.  

Drill down Drilling down lets users view a detailed breakdown of the data by expanding lower levels 
of grid members.  

Drill up Drilling up lets you hide lower levels of data by collapsing grid members into higher 
levels.  

Drill through Drilling through allows the user to drill a data cell down to the raw data at the base of the 
cell value. 

Dimension Selector Using the Dimension Selector allows the user to add and replace dimensions in the 
columns, rows and slicers of the view using drag and drop and to select and filter 
members.  

View View is the main component of a workboard. It retrieves data from a data source and 
shows it in a grid or a chart form. Views can be selected in three ways, either from the 
public, private or shared folders.  

Workboard Workboards provide a default view of data most commonly used. Users can also create 
personalised workboards and share workboards with colleagues.    

6. Access & Login  

DSS System access is requested via email, contact Org Trx support directly. 

Best accessed via Internet Explorer, users will require a 

Username: ___________________________ 

Password: ___________________________ 

7. Support 

Contact: orgtrx-support@health.qld.gov.au 

 

8. General navigation 

The home page consists of three main areas (Figure 1): 

Application bar - The Application Bar is positioned at the top of the workboard on the Necto HTML5 

Client page, it contains the options that apply to the entire application.  

 Homepage ribbon- The Necto ribbon contains workboard link buttons and buttons for changing the 

thumbnail display layout 

 Thumbnail Previews – Recent Workboards – when you log into DSS, the workboards you have visited 

recently display in thumbnail format. 

mailto:orgtrx-support@health.qld.gov.au
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Figure 1 Home page 

 

 

9. Necto work area 

Figure 2 Application bar 

 

Homepage 
ribbon

Application 
bar

Thumbnail Previews –
Recent Workboards



 

 
OrgTRx module user guide - DSS 

Necto v1.4 7 
 

The modules and its folders are located down the left side of the task pane; expand out each folder to view 

standard reports (Figure 3). 

Figure 3 Public Workboards pane 

 

 

9.1 Table view screen (filtering slicer) 

After running a standard workboard from the module in the Public Workboards pane (Figure 3), the table 

view screen is opened (Figure 4).  Figure 4 details options to customise, search and filter in a workboard. 

Figure 4 Table view screen 

 

Double click to 
open a 

workboard.

TIP: Pin down 
the task pane.

Clicking the Show Dimension
Selector enables the user to add and
replace dimensions in the columns,
rows and slicers of the view using

drag and drop functionality.
Hover your mouse over 

the text to make 
selections from the 

menu.

Filter data using the shortcuts 
based on the current view.

Select the View tab to
access the buttons

available.
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9.2  Dimension Selector 

The Dimension Selector allows the user to add and replace dimensions in the columns, rows and slicers of 

the view using drag and drop functionality. It can also be used to select and filter members (Figure 5). 

9.2.1 Add additional slicers - Dimension Selector 

Additional members can be selected from the Dimension Selector and added into a workboard or used to 

filter data to assist with data analysis (Figure 5):  

1. Click on the Dimensions Selector 

2. Click and drag Slicers to and from the Columns and /or Rows Sections 

3. Click on the Slicer, Measures or Rows to filter the data 

4. The View now includes the additional slicers and filters. Click OK 

 

Figure 5 Using the Dimension Selector 
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9.3 Search and filter a slicer 

Search slicers via the Navigation Bar (Figure 6). Search by text or code via the search field depending on 

the slicer e.g. text, code and text or code.   

To search within a slicer: 

1. Click the slicer you wish to search 

2. Type the description/code you are searching for 

3. Click the        Filter to search 

Figure 6 Search option within slicer 

 

9.4    Drill down and Drill up 

Use the drill down option to expand to lower levels of the hierarchy.  For example, if you are viewing the 

Period Hierarchy for 2017 you may wish to drill down to view the individual months or the individual days 

within the months (Figure 7). 

1. Click the       plus to expand to lower levels 

2. Click the      minus to collapse the levels 

Figure 7 Drill down and Drill up 
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9.5 Drill through 

Drilling through allows the user to drill a data cell down to the base of the cell value (Figure 8).  

1. Right mouse click on a cell from the grid e.g. Count 

2. Click Drill through from the menu – a new window will open  

3. Click in the boxes to select/deselect Report Layout Parameters 

4. Click Preview to generate the report  

Figure 8 Drill through  

 

9.5.1 Profile report - check 

Some workboards allow users the option to view a Profile Report e.g. MRSA Profile report. Similar to a drill 

through, this option provides the user with more detailed information about the susceptibility patterns of an 

organism to selected antimicrobials. 

Access a Profile Report (Figure 9): 

1. Right mouse click on a cell from the grid e.g. Count 

2. Click Profile Report from the menu – a new window will open 

3. Click               Download Export to Excel from the top of the window 

Figure 9 Profile report 
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9.5.2 Profile report drill down - check 

Users can drill down on a Profile Report to view detail for an instance (Figure 10).  

Click on the     symbol to drill down to view for example Patient_Code, Lab number etc. 

Once expanded, click on the      symbol to drill up.  

 

Figure 10 Expanded profile report 
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9.6 Select members 

Users can make specific member selections and change the data in the grid via the Select Members option 

(Figure 11). This functionality allows users to select members and customise the grid to display specific 

data.   

To select members (Figure 11): 

1. Click on the member to display the options for example Organism List 

2. Click Select Members, this will open the Select Members in Measures Panel  

3. Select the Members you would like to add from the list on the left or remove from the list on the right 

4. Click        Arrow to move the Members you have selected to the left or click        to remove from the 

list on the right 

5. Click               OK once you are happy with your selection 

 

Figure 11 Select members 
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9.7 Select highlighted members  

The Select highlighted members option allows users to select specific measures and/or members to display 

in the grid.  Multiple members may be selected by holding down the control or shift key.  

To select highlighted members (Figure 12):  

1. Click to highlight the member/s you want to keep. Use the shift or Ctrl key to select a range 

2. Right mouse click on a selected member 

3. Click Select highlighted members from the menu 

 

Figure 12 Select highlighted members 
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9.8 Add and remove dimensions 

Users can add, remove or replace a dimension from within the grid. Dimensions are located in the 

dimension heading. 

To Add and Remove dimensions (Figure 13): 

1. Right mouse click on the Measures in the Heading of the Dimension (e.g. Period Hierarchy) 

2. Select from the Dimension Menu; Replace Period Hierarchy with, Add before or Add after  

3. Select the Dimension you would like to add (e.g. Laboratory Hierarchy) 

4. Right mouse click to display options in the Heading of the Dimension (e.g. Laboratory Hierarchy) 

5. Select Remove Dimension (e.g. Laboratory Hierarchy) 

 

Figure 13 Add and remove dimensions 
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9.9 Replacing sets  

The workboard Cumulative Antibiogram defaults to display the Top 20 Antibiotics and Organisms only. 

To change the Sets (Figure 14): 

1. Right mouse click to display the menu on the Dimension e.g. Antimicrobial 

2. Select Replace Organism List with 

3. Click Sets 

4. Click the set you wish to view – e.g. All Antibiotics ordered by Max Count Organism 

5. Click             OK 

 

Figure 14 Replacing sets 

 

 

9.10  Change grid layout  

The Layout tab provides multiple ways to display a hierarchy in the grid. 

To change the grid layout (Figure 15): 

1. Right mouse click on the measure in the workboard e.g. Organism list 

2. Select Layout 

3. Choose the preferred layout: 

a) Standard layout - displays hierarchal format with no subtotals at a parent level 

b) Standard with parents - displays hierarchal format with subtotals for the parent members 

c) Tree layout - displays members and their parents with subtotals at parent level 

d) Flat layout - removes hierarchies by hiding the parent member 
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Figure 15 Change grid layout 

  

9.11  Rotate grid  

Grids, by default, are plotted along the vertical axis of the grid as the data series and the horizontal axis of 

the grid as the values (Figure 16).  

Figure 16 Rotate grid 

 

1. Click on the   Rotate Grid button to rotate the grid 

10     Saving workboards 

There are three parent folders in the Workboard Task Pane (Figure 17). The folders are visible when the 

Workboard tab and Explore Workboards button are selected in the ribbon. 

        Show public content - contains public reports based on a user’s access approved access 

        Show private content - contains saved private workboards which can be edited and re saved. 

        Content in this folder cannot be viewed by others unless you share it with them 

             Show shared content – contains workboards that other users have shared with you      
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Figure 17 Folder structure 

 

10.1  Create a folder structure  

Users can save workboards in their Private content folder. A folder structure can be created for saving 

private workboards (Figure 18): 

1. Click  Show private content 

2. Right mouse click on the      symbol beside your username  

3. Click New folder 

4. Click in the Enter folder name pane and type in a name for your folder 

5. Click              OK 

Figure 18 Create a new folder 

 

10.2  Save a workboard to your private content folder 

Users can save workboards to their private content folder. Saved workboards can be edited and shared 

with other users. 

To save a copy of a workboard in your private folder (Figure 19):  

1. Click        Save as in the application bar 

2. Enter the report name in the Name field 

3. Click               OK 

4. Once the workboard is saved, click       Save to save changes over a pre-existing workboard 
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Figure 19 Save as 

 

10.3 Open a private workboard  

To open a private workboard (Figure 20): 

1. Click the Private content folder 

2. Click the sub-folder (if you want to save to a folder) then; 

3. Double-click the workboard to open 

Figure 20 Open a private workboard 
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10.4 Export  

Data can be exported in multiple formats. 

To export data (Figure 21): 

 

1. Click          Export button to view and select from the following options: 

 View to PDF – a PDF document will be generated 

 View to Excel – data will be exported in a formatted Excel format (.xls) 

 View image – an image of the workboard is created. The image can be saved to your computer 

 Copy grid to clipboard – allows users to copy the grid and paste into an Excel spreadsheet 

 

Figure 21 Export 

 

11 Sharing workboards 

Users have the ability to share workboards. To share a workboard, you must first save a copy in your 
Private content folder (refer to the previous section for instructions). 

11.1  Sharing a workboard with another user 

To share a workboard with another user (Figure 22): 

1. Click        Show private content  

2. Right mouse click    on the symbol beside the Workboard you would like to share 

3. Select Share from the options menu 

4. Click                          Add Necto users, wait for the user names to load 

5. Click into the search pane and type in the person’s name 

6. Click on the name and move to the Selected users/roles pane 

7. Click OK 

8. Click OK 
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Figure 22 Sharing a workboard 

 

 

 
Note: The user you are sharing a workboard with will not receive any notification, you must notify them.  

To delete a sharing arrangement, click the trash can (Figure 22). 

11.2  Open a shared workboard 

Once a user has shared a workboard with other users it can be accessed via the Shared content folder. 

To open a shared workboard (Figure 23): 

1. Click         Shared Content 

2. Click into the search field and enter the name of the user who has shared report 

3. Click on the user name to highlight 

4. Click OK 

5. Open the folder, locate the view and double click 
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Figure 23 Open a Shared workboard 

 

12 Chart functionality - change 

Charts can be added to or replace a workboard (Figure 24): 

1. Click the                 View tab 

2. Select the            Layout button 

3. Select Show only chart 

4. Select Show only grid to remove chart 

Figure 24 Add/remove a chart 
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12.1 Modify a chart - change 

To modify a chart type via the View tab (Figure 25): 

1. Select        Layout from View in the ribbon 

2. Choose an option; Show Chart or Show Grid and Chart 

3. Select where to place the chart e.g. Chart above grid 

4. Click the         Chart Type to select a default chart from the menu 

5. Click        Rotate to rotate the Axis on your Chart 

6. Click        Legend 

7. Select the position of the Legend 

Figure 25 Modify a Chart 

 

 

 

 

Tip: additional formatting for charting can be found via the Format tab within View Tools. Click on 

Chart and deselect Inherit. 

 

 

 

 

 

 

 

1

2

4

5

6

3



 

 
OrgTRx module user guide - DSS Necto v1.4  23  

 

12.2 Select data to display in the chart change 

You can choose data to display data in the chart by selecting data in the grid. You can only select data from 

members of the same level. 

1. In the grid, click and drag the selection rectangle across a column to display that column in the chart 

2. In the grid, click and drag the selection rectangle across a row to display that row in the chart  

3. In the grid, click and drag the selection rectangle from the member level and drag from left to right and 

down 

4. To capture multiple rows or columns make the first select and then hold down the ctrl key and make 

further selections 

5. To remove a row or column hold down the Ctrl key and drag the selection triangle over that row or 

column 
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